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Installation, configuration, and first launch 

The installation, initial configuration and activation of the plug-in is described 
in  the Quick Setup Guides, which are included with  the  installation package, 
separately for each host application and OS. 

https://www.dehancer.com/help/installation_setup
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Recommended color settings 

Dehancer plugin for Adobe Photoshop / Lightroom Classic / Capture One 
currently supports source images in sRGB IEC61966-2.1 color space 
(other color spaces will be supported as well in the future). 

It is important that the same color management is consistent throughout 
the entire processing and viewing pipeline. 

Please follow the recommended settings: 
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Display Setup 

1. Set your display to its native sRGB color gamut mode if possible. 

2. Use the appropriate calibration profile built especially for your display 
in sRGB, Gamma 2.2 (color temperature is insignificant).  

Tip: On Mac you can also use  the Internet and Web (sRGB) reference 
display preset provided with your new MacBook Pro or Pro Display XDR. 

Adobe Photoshop 

In Photoshop, go to Edit → Color Settings… and set the parameters as shown 
below:  

– Set the working space to sRGB IEC61966-2.1 
– In the Color Management Policies section, select Convert to Working RGB 
mode, and turn on the checkboxes indicated. Now, when you open the photo, 
the color space mismatch will be checked and a conversion to sRGB will be 
suggested. 
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Adobe Camera Raw 

Go to Photoshop → Preferences → Camera Raw… and adjust the settings 
as shown here: 

 
– Select the sRGB IEC61966-2.1 color space 
– Set the color depth to 16 bit 
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Adobe Lightroom Classic 

Check the settings in Lightroom Classic → Preferences → External Editing 

 
– Use TIFF format 
– Select the sRGB workspace 
– Set the color depth to 16 bit 

Use the same settings when exporting from Lightroom if you plan to process it 
later in Photoshop. 
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Capture One Pro 

In the dialogue that follows the Edit With… command, select the appropriate 
options:  

– Format: TIFF 16 bit 
– ICC Profile: sRGB Color Space Profile 
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Recommended RAW development settings 

RAW files for further editing in Dehancer can be processed with almost any 
software available on the market today. 

Photoshop / Lightroom (ACR – Adobe Camera Raw) 

We have observed that color rendering in ACR / Lightroom leaves much 
to  be  desired, but an acceptable result can be obtained with the following 
settings: 

Profile: Adobe Standard 
Exposure: –1 
Contrast: –40 
Blacks: +60 
Curve: Linear 
Sharpening = 0 
Noise Reduction = 0 
Color Space: sRGB IEC61966-2.1 
Bit Depth: 16 bit 

 
If you are shooting with an iPhone and using Apple ProRaw DNG, try setting 
the Amount value for the Apple ProRaw profile to zero. Thus you will reduce 
the automatic Apple algorithms that are not always reliable (but still, sometimes 
acceptable). Meanwhile, we recommend setting the Sharpening value 
in the Detail tab to zero in order to prevent oversharpening. 

Tip: In Photoshop any RAW photo can be opened with the Open As Object 
option. The  smart object will be created and Dehancer plugin will be 
applied as  a  Smart  Filter, which allows you to easily access both 
the RAW settings and the plugin’s parameters at any time. 
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Capture One Pro and other RAW converters 

While processing photos in Capture One Pro and other RAW converters, 
we recommend to: 

• Correct the most severe deviations in exposure and white balance 

• Use the Linear contrast curve if possible, avoiding clipping in shadows and 
highlights 

• Disable noise reduction and sharpening 

• Avoid any local enhancements which might cause visible halos 

• Export files as sRGB TIFF 16 bit 
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Dehancer Plugin Settings 

Hit the gear icon                in the plugin toolbar or press the [S] key to open Dehancer 
plugin Settings. 

Update Film Profiles 

Use this button to launch the Profile Update widget. 

All the new or  missing Film Profiles will be immediately downloaded 
and installed for shared usage with Ps / LrC / C1 plugins. 

Activate Dehancer / License Info 

This button launches the Activation widget that allows to check your License 
status and to activate the plugin.  

Processing GPU 

If there are multiple GPUs available in your system, you can manually select 
the best-performing one. You can also try a different GPU in case of any specific 
problems with the plugin. 

Fast Preview 

This setting allows progressive rendering of the preview for images that are 
larger than the specified size limit. This makes Dehancer interface more 
responsive when working with large images on low-performance computers. 

Related articles: 

F.A.Q.: Dehancer plugin and Profiles Update 
F.A.Q.: How to buy and activate the License?

→

https://blog.dehancer.com/faq/#19
https://blog.dehancer.com/faq/#31
https://blog.dehancer.com/faq/#19
https://blog.dehancer.com/faq/#31
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Interface and keyboard shortcuts 

Show/Hide left panel

Show/Hide Settings [S]

Reset all adjustments 
to their defaults [R] 

Restore last used settings [L]

Show/Hide Profiles [Q]Profiles

Show/Hide Presets [W]Presets

Undo last edit [Z]

Redo last edit [Shift+Z]

Show/Hide Levels (Histogram) [i]

Preview Before/After [Space]Preview

Zoom to fit / Zoom to 100%
[Double click] 

on the image preview  
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Visit Dehancer web storeBuy License

Add selected Film Profile 
to Favorites

Delete selected Preset [Backspace]

Close Dehancer plugin window 
without applying any changes [Esc]Cancel

Apply Dehancer processing [Enter]OK

Create new Preset 
with current settings [A]

Export selected Preset to file

Import Preset from file

Select next Film Profile [↓]

Select previous Film Profile [↑]
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Typical photo editing workflow 

Dehancer is a versatile tool that allows a variety of approaches. However, based 
on our experience, we can provide an all-purpose workflow for photo 
processing. 

1. Develop your RAW photo 

Working with RAW is always the preferred option because it contains 
lots  of  useful information and, most importantly, it is free of the excessive 
processing that is typical of smartphone cameras in particular. 

Detailed advice on processing RAW files is given in the Recommended RAW 
development settings chapter of this manual. 

2. Adjust Source Corrections 

The original image may still have some issues, which can be conveniently 
corrected immediately with the Source Corrections tool. 

3. Choose a Film Profile and adjust the Push/Pull 

Choose the Film Profile that best suits your scene. Note that you can switch 
between Film Profiles with the up and down arrow hotkeys. 

Also, remember that the Push/Pull option gives you the opportunity to further 
adjust the profile appearance according to the film exposure. 

4. Adjust the Expand settings 

We recommend adjusting Expand immediately after a film profile selection. 
Set  the black and white points to ‘fit’ an image into  a  dynamic range 
of your color space. 

5. Configure Print options 

Start by selecting Print Medium, then sequentially adjust Exposure, Contrast, 
and other Print settings. 

To improve the detail at the extremes of the tonal range, you can optionally 
enable the Analogue Range Limiter. 
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6. Revisit the Expand tool 

Since the edits you made in the previous step can significantly affect the black 
and white points, it is recommended that you readjust the Expand settings. 

7. Adjust the CMY Color Head 

After setting the tone of the image, you can make further adjustments to the 
color balance. The CMY Color Head tool is perfect for this kind of fine-tuning. 

8. Enable additional effects 

Some salt and pepper will make the dish even better. 

 

Related article: 

How to manage image contrast and avoid clipping
→

https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
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Batch processing multiple photos 

A series of photos are often edited with the same or similar settings. The most 
convenient way to organize the process is to use a combination 
of Adobe Photoshop and Dehancer Film plugin. 

Last Edits 

Dehancer is automatically saving your last edits every time you apply 
the processing with the ‘OK’ button in the plugin. 

When you open the next image, you will see that the latest settings have 
automatically been applied to it. Even if you've changed some parameters, 
you  can always recall the last settings by clicking the corresponding icon 
in the toolbar: 

 

Also, you can click the Last Edits preset with the same effect. 

To apply Dehancer with your last edits without opening the  plugin interface, 
press Ctrl+Cmd+F  (macOS) / Ctrl+Alt+F  (Windows) or  select Dehancer Film 
in the top-line of the Photoshop Filters menu. 

Attention: The Last Settings and Last Filter are retained during the current 
Photoshop session and will be lost when you close the host application. 

Dehancer Presets 

Presets are a more reliable way to keep your favourite settings for a long-term 
storage.  

Once you have achieved the desired result, press A button on the keyboard 
or click the appropriate icon in the Presets panel: 
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Tip: Presets can also be exported and imported, allowing you to share 
them with others or save them as a backup. 

Non-destructive editing with Smart Objects and Smart Filters 

When you edit a normal layer, the effects are permanent and you can't alter 
the plugin settings once it has been applied. 

The Smart Object allows you to enclose the source layer in a ‘container’, 
and your corrections and effects will be applied to it, with the option to switch 
each filter on, off, or change settings at any time, without affecting the original 
image permanently. This is the main concept of the non-destructive editing. 

The Smart Filter settings are stored inside the document, so they are not lost 
when you restart Photoshop. You just need to save the image as a PSD or TIFF 
file with layers. 

Dehancer fully supports the Smart Filter functionality. This means that after 
applying the plugin to a Smart Object, you can revisit Dehancer settings at any 
time and make the adjustments. 

To apply Dehancer as a Smart Filter: 

1. Select the layer. 

2. Press the right mouse button and click Convert to Smart Object. 

3. Thereafter, Dehancer (like any other filter) will be applied automatically 
as a Smart Filter. 

This feature can also be used to transfer settings from one photo 
to another. To do this, the source and target photos must be Smart Objects 
in the same document. Then  the  entire set of filters and corrections, 
including Dehancer, can be moved from one Smart Object to another 
by drag-and-drop. 
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Using Dehancer in Photoshop Actions 

Actions allow you to record and playback any sequence of image manipulations, 
including filters and plugins. 

Dehancer fully supports the Photoshop Actions functionality. This means that 
all plugin settings once recorded will be reproduced when the action 
is executed. 

Actions can be launched manually with every photo or used in batch processing. 

Tip: Dehancer settings saved in an action can be easily adjusted. 
To do this, open the Actions tab, find the particular action and double-click 
the Dehancer Film step. 
Dehancer window will open and now you can make adjustments. 
Then click OK and the action will be updated with the latest changes. 

Batch processing with Actions  

In Photoshop any action can be automatically applied to the opened images 
or even to the entire folder on your hard drive. 

You can use the two built-in Photoshop tools that work in a very similar way, 
but have a slightly different options: 

 
File → Automate → Batch 

1. In the Play section select your pre-recorded Dehancer action. 

2. As the Source you can choose a Folder or the Opened Files. 

3. Select the Destination (‘Save and Close’ overwrites the source images, while 
‘Folder’ saves duplicates). 

4. Click ‘OK’ and all your photos will be processed and saved automatically.  
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File → Scripts → Image Processor 

1. Select the images to process (choose a Folder or the Open Images). 

2. Select location to save processed images (‘Save in Same Location’ 
overwrites the source images, while ‘Select Folder’ saves duplicates). 

3. Select File Type, quality and resize options, if needed. 

4. In the Preferences section check the Run Action option and select your 
pre-recorded Dehancer action. 

5. Enable the Include ICC Profile option to ensure that your photos will display 
correctly in any application or web browser. 

6. Click ‘Run’ and all your photos will be processed and saved automatically. 
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Film Profiles, Push/Pull 

Film Profiles are heart and soul of Dehancer. Each film is accurately sampled 
with all of its characteristics. If you are ready to bet on years of film experience – 
then you can simply scroll and try film profiles in the list until you get the most 
interesting or desired results. 

Push/Pull (Ev) 

All films behave differently depending on how much light they received during 
exposure. In Dehancer film exposure is implemented with the Push/Pull (Ev) 
parameter. In  fact  there are 3 different film exposures sampled to build each 
film profile in Dehancer. 

As a creative tool Push/Pull allows you to vary color-contrast look of a scene 
within a selected film profile. Also, Push/Pull can be a good helper in clipping 
control, since contrast greatly depends on film exposure. With negative films it 
affects overall color and contrast. With positive films Push/Pull allows to set the 
desired slide exposure, opening blocked shadows or protecting blown-out 
highlights. 

Tip: We optically print negative B&W fi lms on the famous 
Slavich  Bromportrait paper known for its noble warm tone. If you need 
a  pure black and white look, you may set the Saturation = 0 
in the Print section at any time. Also you can try CMY Color Head and Print 
Toning parameters to adjust tint and split-toning at your taste. 

 

Related articles: 

How we build film profiles 
What is Push/Pull and how it works? 
Modern motion picture color negative films 
Complete list of Dehancer film profiles

→

https://blog.dehancer.com/articles/how-we-build-film-profiles/
https://blog.dehancer.com/articles/what-is-push-pull-and-how-it-works/
https://blog.dehancer.com/articles/modern-motion-picture-color-negative-films/
https://www.dehancer.com/profiles
https://blog.dehancer.com/articles/how-we-build-film-profiles/
https://blog.dehancer.com/articles/what-is-push-pull-and-how-it-works/
https://blog.dehancer.com/articles/modern-motion-picture-color-negative-films/
https://www.dehancer.com/profiles
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Source corrections 

Source corrections are meant to quickly compensate for obvious technical 
issues of a source material. 

Exposure Comp. 

This setting can be used to compensate for the exposure errors of the source 
media. 

Unlike the Exposure setting in Print tool, this is a technical correction 
of  the  original image before any Dehancer effects are applied. Conversely, 
Print Exposure is rather a creative setting, the results of which largely depend on 
the selected profile, print media, and other settings within the plugin. 

Temperature Comp., Tint Comp. 

These settings technically work in a similar manner but  in  relation 
to the temperature and tint of the source. 

Defringe 

Defringe helps to deal with the chromatic aberrations visible at the edges 
that  may interfere with some of the Dehancer effects, such as Halation 
and Bloom. 

Tip 1: Temperature and Tint compensation are better suited for strong 
deviations of  a source, while Color Head is designed mostly for  creative 
application and more subtle adjustments. 
 
Tip 2: In some particular cases Defringe may lead to visible halos around 
the edges in combination with the Bloom or Halation effects. Lowering 
 the Defringe amount and radius settings helps to deal with this issue. 
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Film Developer 

The conventional analogue approach makes it possible to process film 
by  individually configuring the formula of the developer solution 
and  the development process. Film Developer tool allows to make your own 
development recipe depending on the source material, shooting conditions 
and creative tasks. 

Contrast Boost 

This parameter controls the developer contrast. In analogue processes, 
development contrast is determined by developer temperature 
and  concentration. In Dehancer this parameter can take both positive values 
(contrast increases) and negative values (contrast decreases). 

Gamma Correction 

In film processing gamma correction controls the contrast ratio of a negative, 
in  relation to the exposure time. This parameter determines how much 
the  midtones are shifted towards shadows or highlights. Gamma correction 
is possible with any Contrast Boost value other than zero. 

Color Separation 

The color separation of the negative film is determined by the color filters 
in  the  emulsion layers, the sensitisation of each layer and their order. 
In Dehancer you can control the ‘chemical component’ of the developer, which 
affects the sensitisation of the emulsion layers. 

When Color Separation value is reduced, saturation of the most intense colors 
is  reduced first, while medium and low saturation colors remain almost 
unaffected. 

By default, the Color Separation setting has a maximum value of +100. It affects 
the image at any Contrast Boost value other than zero. 
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Color Boost 

Some color development processes allow saturation to be controlled 
by  the  properties of the dyes that are introduced into the emulsion 
at  the  development stage. In Dehancer, this feature is implemented 
in  the  Color  Boost parameter, which increases or decreases the overall 
saturation of the image (not only the most saturated colors, as with 
Color Separation). This type of color enhancement is gentle and does not lead to 
clipping, i.e. all colors remain inside the color gamut. 

Practical tasks that can be solved with Film Developer: 
 
- Grading a source with an undefined gamma, contrast and color, 
for example, a JPEG from an unknown camera and exposure conditions. 
 
- Making additional adjustments to the interpretation of the source 
material. 
 
- Adjusting the excessive or insufficient contrast, which you want 
to normalise and make more flexible for further processing. 
 
- Increasing the overall saturation, while avoiding oversaturation and color 
clipping where possible. 

 

Related article: 

Film Developer – a new Dehancer tool
→

https://blog.dehancer.com/articles/film-developer-a-new-dehancer-tool/
https://blog.dehancer.com/articles/film-developer-a-new-dehancer-tool/
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Film Compression 

Usually on a negative film, clipping in  the  highlights occurs much later than 
on a digital camera. 

To  emulate the  film-like compressed tonal range, we  invented 
the  Film  Compression tool. It lets you fine-tune the  redistribution 
of the highlights. The resulting image looks more analogue and becomes more 
flexible for further manipulation with exposure, contrast, film/print profiles, etc. 

Impact 

This parameter determines the degree of compression. The higher the Impact 
value, the more the highlights are pushed towards the midtones. 

White Point 

The White Point parameter defines the  ‘film clipping threshold’, and directly 
affects contrast because it  determines the  steepness of  the  transition 
to  the clipping area. As  the white point gets closer to  the midtones, the more 
contrast the image appears. 

By default, White Point = 100. This means that it stays at its initial position. 

The  White Point can be lowered, thereby increasing the  overall contrast 
of  the  compressed range. The minimum possible value is  50. The lower 
the White Point is, the more likely clipping will occur in the highlights. 

Alternatively, the white point value can be  increased. In  this  case, the overall 
contrast of  the  compressed range is  reduced. The  maximum possible value 
is 120. The higher the White Point  is, the more flat and grayed the highlights 
appear. 

Tonal Range 

This parameter represents the  width of  the  tonal  range affected by 
Film  Compression tool. A  minimum value  =  0 means no  compression. 
A maximum value = 100 means that the  compression affects the wide range 
from the brightest highlights almost all the way down to the deepest shadows. 
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Color Density 

Different films reproduce color differently as  they get closer to  the highlights. 
Negative  films tend to  noticeably loose saturation in  the  highlights. 
Slides remain more vibrant, even though the clipping occurs earlier. 

The Color  Density parameter controls the  color intensity of  the  compressed 
range. Color  Density  =  0 produces the  lowest saturation in  the  highlights, 
which is more typical for negative films. Color Density = 100 provides maximum 
saturation, and the image looks more like positive films. 

Tip: Although the Film Compression tool is not designed to restore 
highlights lost in the source file, you can still use it effectively to make 
the highlights more textured and smooth out the clipping. 

 

Related article: 

Film Compression — new Dehancer tool
→

https://blog.dehancer.com/articles/film-compression-new-dehancer-tool/
https://blog.dehancer.com/articles/film-compression-new-dehancer-tool/
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Expand 

Expand tool provides a separate manual control for black and white points 
in relation to the output color space. 

All films naturally have different contrast, different black and white points. 
At  the  sampling stage, we avoid digital correction to preserve the individual 
features of the films, which  ensures a fair and convincing simulation. 
Thus,  film  profiles in Dehancer, without  additional adjustment, usually lack 
contrast, but at the same time they  have a lot of headroom for creative 
adjustments. 

We recommend adjusting Expand immediately after a film profile 
selection. Set the black and white points to ‘fit’ an image into a dynamic 
range of your color space.  
 
During a grading session you will probably revisit this tool several times. 

Color Mode 

The Color Mode option can be useful if you encounter unwanted color shift 
or  oversaturation. In the Luma mode Expand affects only the luminance 
component of an image, but does not affect its color, so the changes in contrast 
have no effect on the saturation. 

Tip: If your source doesn’t have enough headroom for the Expand 
adjustments try  to  enable the Analogue  Range  Limiter checkbox 
in the Print toolset which gives more ‘relaxed’ extremes. 

Also you can use the Film Compression tool to make the highlights more 
textured and smooth out the clipping. 

 

Related article: 

How to manage image contrast and avoid clipping
→

https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/


27

Print Medium 

Optical printing is the last stage of the analogue production. As the result we get 
a paper print for direct viewing or a positive film for screen projection. Both can 
be scanned for digital delivery. Optical printing is the only analogue solution that 
can be used for proper interpretation of the negative films. 

Beyond the technical significance, any print medium has its own tint, photo 
latitude and contrast curve that makes it a useful creative tool.  

In the Print parameters group, you have a choice of the print mediums: 

Linear 

Only a ‘pure’ profile of a selected film is used, without the influence 
of the characteristics of photographic paper. 

Cineon Film Log 

Selected film is ‘printed’ into Cineon film scan format. This parameter also 
makes it possible to ‘print-out’ negatives outside Dehancer. 

Kodak 2383 Print Film, Fujifilm 3513 Print Film 

Selected film is ‘printed’ onto Kodak Vision Color Print Film 2383 or 
Fujicolor Positive Film Eterna-CP 3513DI. 

Kodak Endura Glossy Paper 

Selected film is ‘printed’ onto Kodak Endura Premier Glossy Paper. 

Tip: It is convenient to follow the analogue pipeline when matching 
the print medium with the film. Use the Linear profile with positive films, 
Kodak 2383 or Fujifilm 3513 for corresponding movie stocks and Kodak 
Endura paper for photographic negative films. However, experiments are 
always welcome. 

 

Related article: 

Print Film Profiles in Dehancer
→

https://blog.dehancer.com/articles/print-film-profiles-in-dehancer/
https://blog.dehancer.com/articles/print-film-profiles-in-dehancer/
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Print Settings 

Relying on our experience in optical printing and our research 
into  the  psychophysiology, we have developed the dedicated print settings 
that faithfully reproduce the analog processes: 

Target White 

Only available when Kodak 2383 Print Film or Fujifilm 3513 Print Film 
is selected. Allows to adjust the temperature of the printing light source in the 
5500-6500 K range. 

Exposure (Ev) 

The Exposure tool is based on characteristic curves of optical prints. 
With  the  analogue approach to the exposure correction it naturally affects 
the  image contrast too. This  parameter is measured in the exposure value 
steps (Ev). 

Tonal Contrast 

The Tonal Contrast tool inherits a nonlinear nature of analogue processes. 
Increase  the value to give more punch or apply negative correction to visually 
‘soften’ an  image. Notice that changing the contrast also visually affects 
the exposure, which is also typical for analogue media. 

Color Density 

Traditional ‘digital’ saturation affects all hues equally and linearly. 
On  the contrary, the Color Density tool provides perceptual saturation control, 
i.e. it affects aesthetically significant colors in a higher degree. 

Color Density can be used to quickly solve many specific problems – 
for example, to mitigate oversaturated accents or emphasise meaningful colors 
without painstaking adjustment. 
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Saturation 

This is a more "traditional" saturation control based on altering the chroma 
components in YCrCb space. This correction is available only in the reduction 
way due to the fact that oversaturation usually degrades the aesthetics. 

Analogue Range Limiter 

By default, Print adjustments work within the boundaries of the ‘digital’ contrast 
range. Black  and white points are normalised to the digital brightness values 
of 0 and 100, respectively. 

To obtain a softer image and improve the detail at the extremes of the tonal 
range, enable the Analogue Range Limiter which uses the uncorrected black 
and white point values as they were measured on the reference prints. 

Tip 1: Even though Tonal Contrast uses sophisticated nonlinear 
compression, it may lead to some clipping at high values. If this happens, 
revisit Expand to  set  a  more ‘relaxed’ cutoff for black and white points 
or  enable the  Analogue  Range Limiter checkbox to get more headroom 
for  processing. Also you can use the Film Compression tool to make 
the highlights more textured and smooth out the clipping. 
 
Tip 2: To get a saturated and expressive image, we recommend starting 
with  increasing the contrast and simultaneously slightly decreasing 
the  exposure. You can also adjust the Color Density to emphasise 
your colors. 
 
Tip 3: Some combinations of the print settings may produce colors falling 
out of the gamut, with visible artefacts, especially when Color Density 
is  increased. In this case lower the contrast and saturation or try another 
film or print media profile. 

 

Related article: 

How to manage image contrast and avoid clipping
→

https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
https://blog.dehancer.com/articles/how-to-manage-image-contrast-and-avoid-clipping/
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CMY Color Head and Print Toning 

Subtractive CMY Color Head is based upon the analogue color correction tool 
integrated in  photo enlargers. The similar method is used in Printer Lights – 
a special device for optical movie printing to a positive film. Both have the same 
principle – changing the color of light used for print exposure.  

In Dehancer the Color Head tool is represented with three complementary color 
pairs (YMC-BGR or commonly used CMY-RGB), combining both analogue 
devices into one digital tool: 

Yellow — Blue 
Magenta — Green 
Cyan — Red 

The effect of changing these parameters corresponds respectively 
to their labels. 

Gang 

Dehancer uses the real-life measured color filters values. Thus, even with 
the identical adjustments in all three axis, the color changes are visible. For your 
convenience, we  have  provided the Gang checkbox, which allows changing 
all three filters at once. 

Shadows Tone 
Midtones Tone 
Highlights Tone 

In a general analogue sense, toning refers to giving a paper print or film positive 
additional tints that  are not originally characteristic of a particular media 
combination. This technique is widely used in movie production to give a special 
character or atmosphere when the original film properties are insufficient. 

Unlike the digital world, where you can ‘fill’ the entire picture with a single hue, 
analog media is more varied. In addition to the natural variations across 
the  tonal range, a  print can be intentionally colored with  different 
tints in the shadows, midtones, or highlights. 
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Toning can be achieved using a variety of methods, including special exposure 
and processing mode, additional treatment with various chemicals, and split 
printing through color filters with masking. 

In Dehancer, the toning control is a natural evolution of the CMY Color Head tool. 
Therefore, it’s based on split printing through color filters, with the only 
difference that masking is performed automatically. 

You can control the color temperature separately within three equally quantised 
ranges – in shadows, midtones, and highlights. 

Preserve Exposure 

During the analogue printing the exposure is affected by color filters. 
Dehancer  inherits this behaviour. When Preserve Exposure is set to 100%, 
it  automatically compensates any  exposure changes, introduced 
by the Color Head corrections. 

Impact 

This slider adjusts an overall impact of the effect, acting like ‘opacity’. 

Tip 1: Prefer the Color Head tool for creative adjustments, while leaving 
the  Input  Temperature and Tint compensation for strong WB deviations 
of a source material. 
 
Tip 2: Setting the Preserve Exposure slider to zero results in exposure 
changes during color correction – just the way it does with the analogue 
printing process. This is an additional way to naturally change an image 
density in Dehancer. 

 

Related article: 

CMY Color Head – analogue correction for digital images
→

https://blog.dehancer.com/articles/color-head/
https://blog.dehancer.com/articles/color-head/
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Film Grain 

Real grain on film isn’t just overlaid on top of an image, but in fact the image 
itself entirely consists of  grain. Dehancer literally reconstructs the shot, using 
the local color and  brightness characteristics along with a complex physical 
modelling of a film emulsion. 

There are 2 film types and 2 processing modes available in Dehancer: 

Film Type 

1. Negative grain is more pronounced in the highlights and the image 
has a slightly higher microcontrast, which is more typical for negative films. 

2. Positive grain uses the ‘classic’ algorithm that reproduces a softer grain, 
which is less pronounced in the highlights and is more typical for positive 
films. 

Processing Mode 

1. Analogue is the original type of grain that requires more processing power 
but results in lifelike simulation. 

2. Digital (Experimental) is the high performance simplified grain 
that may be useful for dithering tasks (for example, to eliminate 
the posterisation), for low-resolution projects and draft rendering. 

Size 

This parameter determines a size of silver halide granules. A higher Size value 
corresponds to a more photosensitive (and therefore more granular) emulsion. 

Amount 

Total amount of grain generated, corresponding to a ‘film’ optical density. 
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Shadows, Midtones, Highlights 

This parameter affects grain distribution between different zones of a tonal 
range to match your scene texture and grading look by setting the grain amount 
individually for shadows, midtones and highlights. 

Film Resolution 

Usually the smallest image detail on film does not exceed the grain size. 
Dehancer  Film  Grain is considering this fact by design. Also it is possible 
to  manually adjust this effect to mimic a specific emulsion resolution 
or to compensate for an excessive image softness. 

Film Resolution parameter set to 100 keeps the initial sharpness of a source 
media. Lowering the Resolution results in gradual loss of detail, while an image 
becomes more blurred.  Resolution set to 50 represents the  detail balanced 
with a current grain size and amount. 

Chroma 

Grain chromaticity may vary on different films. This parameter determines 
the saturation of the dye granules in film emulsion. 

Tip 1: On the real film, grain can be found in both the deepest shadows 
and  the  lightest highlights. But it cannot be visible on pitch black or pure 
white – technically  there’s no  detail in  there. That is why Film Grain 
naturally affects black and white points, lowering visible contrast when 
enabled. Thus the Expand correction is recommended to regain 
the contrast. 
 
Tip 2: Sometimes, even at the minimum Size and Amount settings, grain 
appears too obvious for some applications. To get even subtler and softer 
grain lower the  Shadows, Midtones and Highlights values and  use 
the Film Resolution to make-up the excessive sharpness. Also you can try 
different grain types and processing modes. 

Related article: 

How does film grain work in Dehancer OFX plugin
→

https://blog.dehancer.com/articles/how-does-film-grain-work-in-dehancer-ofx-plugin/
https://blog.dehancer.com/articles/how-does-film-grain-work-in-dehancer-ofx-plugin/
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Halation 

Halation is the film emulsion effect visible as the local red-orange halos around 
the bright light sources, specular highlights and contrasting edges. Also, halation 
may produce a  well  pronounced red glare in  the midtones, mostly affecting 
the skin tones. 

Source Limiter 

This setting defines the minimum light source brightness that is able to produce 
halation. The  default value = 0 means that even the weakest source is able 
to produce halation. By  increasing this value, you can cut the effect produced 
by low intensity lights. 

Background Gain 

This parameter sets the range of the background tones on which halation 
becomes visible. Default value allows halation to appear on most backgrounds. 
Decreasing this value eliminates the effect over the lighter ones. 

Smoothness 

This integral parameter controls the distribution of the halation effect between 
the large and  small sources, visually smoothing smaller halation details. 
Increasing the Smoothness value reduces the effect around the point sources in 
favour of  the larger areas. Setting the Smoothness to zero leads to the most 
detailed halos. 

Local Diffusion 

This parameter defines how far the light spreads in an ‘emulsion’. The higher 
the Local Diffusion value, the larger the geometric size (radius) of the halos. 



35

Global Diffusion 

Global Diffusion controls the degree of the secondary glare produced 
by scattered light. This  is a more global effect that affects mostly low-contrast 
midtones and also enhances the primary halation. 

Amplify 

It is important not to confuse this setting with the Impact as the Amplify affects 
the  sensitivity of an ‘emulsion’ to the scattered light, not the opacity 
of  the effect. Increasing the Amplify value makes the effect more pronounced 
and shifts the halation toward yellow hues. 

Hue 

This parameter modifies the sensitivity of the green layer of an ‘emulsion’ 
to the scattered light. Use this setting to better match halation hues to a scene 
in the wide range from cool reds to warm yellows. 

Blue Comp. 

Cool backgrounds usually dampen the halation. Blue Compensation allows 
to counterbalance this effect. 

Impact 

This parameter can be conventionally referred to as ‘opacity’, since it controls 
not  the  physical parameters of  the  emulation, but the overall transparency 
of the superimposed effect. 

Mask Mode 

This checkbox enables a special preview mode which allows you to better 
control the settings with the effect preview isolated from the source image. 
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Halation + Defringe 

In some cases chromatic aberrations interfere with the Halation effect. 
Defringe tool helps to deal with this issue. 

Halation + Bloom 

Usually these effects coexist on film and mutually influence each other. 
Therefore, it  is  generally best to use Halation and Bloom in tandem to get a 
more accurate simulation. 

Tip 1: Halation effect is most pronounced when Source Limiter 
is at  its  lowest and Background Gain at its highest settings, with Amplify 
set to maximum. It can be a good starting point – just gradually reduce 
the effect until getting optimal results. 
 
Tip 2: Increasing the Global Diffusion can be an instant solution 
to  naturally enhance any portraiture, filling the skin tones with a  touch 
of vivid warm glare. 
 
Tip 3: If Halation appears too dim or invisible in Mask Mode, 
try to temporarily increase the Amplify and Impact values. 

 

Related article: 

Halation and its simulation in Dehancer
→

https://blog.dehancer.com/articles/halation/
https://blog.dehancer.com/articles/halation/
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Bloom 

Bloom emulates the combined effect of light dispersion on the boundaries 
of  contrasting image areas, which originates in the optical system, 
and  then  amplified in the emulsion layers. Notice that bloom has little 
in common with optical soft-effects as it appears only around the light sources. 

Highlights 

In general, this setting may be considered the ‘sensitivity’ of the effect 
and  determines the  brightness threshold for bloom to appear. The higher 
is the value, the wider the tonal range that produces blooming is. 

Source Limiter 

Source Limiter is used to cut-off the unwanted blooming from the lower end 
of the tonal range defined by the Highlights setting. 

Details 

This setting controls the distribution of the bloom effect between large 
and  small light  sources. Increasing the value makes the effect more detailed 
and precise, up  to  the  smallest point sources. Lowering the Details results 
in a more global effect across a frame, affecting larger objects. 

Diffusion 

Diffusion controls the extent of the bloom effect relative to the boundary where 
it  appears. The bigger is the Diffusion value, the larger is the geometric size 
of the glow radius. 

Amplify 

Amplify controls the overall effect strength by virtually ‘changing’ the brightness 
of  a  light source and the diffusion properties of an emulsion. The higher 
the value, the more obvious the whole effect becomes. 



38

Save Lights 

Bloom affects not only the background but also increases brightness of a  light 
source itself. In  digital pipeline this may lead to visible clipping. Save  Lights 
simply does what it’s supposed to do, protecting highlights from  possible 
clipping induced by the Bloom effect. 

Saturation 

Naturally Bloom inherits the hue and saturation of a light source. This setting 
makes it possible to desaturate the effect at your taste.. 

Impact 

This parameter can be conventionally referred to as ‘opacity’, since it controls 
not  the  physical parameters of  the  emulation, but the overall transparency 
of the superimposed effect. 

Mask Mode 

This checkbox enables a special preview mode which allows you to better 
control the settings with the effect preview isolated from a source image. 

Tip 1: Sometimes with extreme settings Bloom may produce excessive 
halo-like artefacts. In this case try to increase the Save Lights, decrease 
the Amplify value and disable the Defringe tool. 
 
Tip 2: If Bloom appears too dim or invisible in Mask Mode, 
try to temporarily increase the Amplify and Impact values. 

 

Related article: 

Bloom: what it is and how it works
→

https://blog.dehancer.com/articles/bloom-what-it-is-and-how-it-works/
https://blog.dehancer.com/articles/bloom-what-it-is-and-how-it-works/
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Vignette 

In lens design vignetting is usually considered a flaw. However, it is also 
a proven creative tool that allows for better focusing on a subject and adds extra 
depth. Also, in digital processing vignette with positive exposure values can be 
used to compensate for unwanted vignetting. 

Exposure 

Negative Exposure values result in dark vignette while positive values, 
respectively, produce the light vignette. 

Size 

This setting defines a size of the vignetting circle. 

Feather 

Feather controls the amount of blur applied to the vignette circle. 

Aspect Ratio 

This parameter affects the proportions of the vignette, allowing to make 
it elliptical (in both the X and Y directions). 

Tip: Although the Vignette tool is located at the very bottom 
of  the  Dehancer settings, we recommend to adjust it  at  the  beginning 
of color grading since it affects the exposure and usually increases contrast 
between the edges and  a frame center, thus requiring additional 
adjustments of the exposure and contrast. 
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Application path and user data location 

Below you can find the main system paths of the installed application 
components and user data locations, which you may need when contacting 
support or maintaining the plug-in. 

Installation (macOS) 

Adobe Photoshop plugin: 
/Library/Application Support/Adobe/Plug-Ins/CC/Dehancer 

Adobe Lightroom and Capture One plugin: 
/Applications/Dehancer Lightroom Plugin/Dehancer Lightroom Plugin.app 

User Data (macOS) 

Shared folder: 
/Users/{user}/Library/Application Support/com.dehancer.film_shared 

User Presets folder: 
/Users/{user}/Library/Application Support/com.dehancer.film_shared/presets 

Adobe Photoshop plugin log: 
/Users/{user}/Library/Application Support/com.dehancer.film_shared/
dehancer_logs/photoshop_plugin.log 

Adobe Lightroom and Capture One plugin log: 
/Users/{user}/Library/Application Support/com.dehancer.film_shared/
dehancer_logs/lightroom_plugin.log 

Standalone application log: 

/Users/{user}/Library/Application Support/com.dehancer.film_shared/
dehancer_logs/dehancer_pro.log 
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Installation (Windows) 

Adobe Photoshop plugin: 
C:\Program Files\Common Files\Adobe\Plug-Ins\CC\Dehancer 

Adobe Lightroom and Capture One plugin: 
C:\Program Files\Dehancer Lightroom Plugin\Dehancer Lightroom.exe 

User Data (Windows) 

Shared folder: 
C:\Users\{user}\AppData\Local\dehancer\com.dehancer.film_shared 

User Presets folder: 
C:\Users\{user}\AppData\Local\dehancer\com.dehancer.film_shared/presets 

Adobe Photoshop plugin log: 
C:\Users\{user}\AppData\Local\dehancer\com.dehancer.film_shared/
dehancer_logs/photoshop_plugin.log 

Adobe Lightroom and Capture One plugin log: 
C:\Users\{user}\AppData\Local\dehancer\com.dehancer.film_shared/
dehancer_logs/lightroom_plugin.log
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